
SACE11
SAP Analytics Cloud Foundation

.
.

EXERCISES AND SOLUTIONS
.

Course Version: 34
Exercise Duration: 5 Hours 25 Minutes
Material Number: 50161798





SAP Copyrights, Trademarks and 
Disclaimers

© 2023 SAP SE or an SAP affiliate company. All rights reserved.

No part of this publication may be reproduced or transmitted in any form or for any purpose without the 
express permission of SAP SE or an SAP affiliate company.

SAP and other SAP products and services mentioned herein as well as their respective logos are 
trademarks or registered trademarks of SAP SE (or an SAP affiliate company) in Germany and other 
countries. Please see https://www.sap.com/corporate/en/legal/copyright.html for additional 
trademark information and notices.

Some software products marketed by SAP SE and its distributors contain proprietary software 
components of other software vendors.

National product specifications may vary.

These materials may have been machine translated and may contain grammatical errors or 
inaccuracies.

These materials are provided by SAP SE or an SAP affiliate company for informational purposes only, 
without representation or warranty of any kind, and SAP SE or its affiliated companies shall not be liable 
for errors or omissions with respect to the materials. The only warranties for SAP SE or SAP affiliate 
company products and services are those that are set forth in the express warranty statements 
accompanying such products and services, if any. Nothing herein should be construed as constituting an 
additional warranty.

In particular, SAP SE or its affiliated companies have no obligation to pursue any course of business 
outlined in this document or any related presentation, or to develop or release any functionality 
mentioned therein. This document, or any related presentation, and SAP SE’s or its affiliated companies’ 
strategy and possible future developments, products, and/or platform directions and functionality are 
all subject to change and may be changed by SAP SE or its affiliated companies at any time for any 
reason without notice. The information in this document is not a commitment, promise, or legal 
obligation to deliver any material, code, or functionality. All forward-looking statements are subject to 
various risks and uncertainties that could cause actual results to differ materially from expectations. 
Readers are cautioned not to place undue reliance on these forward-looking statements, which speak 
only as of their dates, and they should not be relied upon in making purchasing decisions.

© Copyright. All rights reserved. iii

https://www.sap.com/corporate/en/legal/copyright.html


Typographic Conventions

American English is the standard used in this handbook.

The following typographic conventions are also used.

This information is displayed in the instructor’s presentation

Demonstration

Procedure

Warning or Caution

Hint

Related or Additional Information

Facilitated Discussion

User interface control Example text

Window title Example text
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Unit 1
Exercise 1

Explore the SAP Analytics Cloud user interface

Business Example

You are new to SAP Analytics Cloud and so you need to learn how to use the Home page and 
perform a few navigation tasks.

Task Flow

In this exercise, you will perform the following tasks:

● Navigate the SAP Analytics Cloud user interface

● Use the Search to Insight feature

Task 1: Log on to SAP Analytics Cloud

1. Log on to SAP Analytics Cloud. Go to the next task if you are already logged in.

● User: A## or B##
## is your 2-digit group number, and the letter is what your instructor assigned to you.

● Password: Welcome1

If prompted, choose Accept in the Welcome dialog.

Task 2: Explore the SAP Analytics Cloud User Interface

1. Determine the current revision level of the SAP Analytics Cloud you are using. Use the 
help to access information regarding new features.

2. Open your user profile. Locate the log out option. Edit the User Preferences but do not 
change them.

3. Explore the Navigation Bar on the left side by selecting/expanding each of the following 
menu options. If needed, use the ...More option.

● Home

● Files

● Stories

● Analytic Applications

● Data Analyzer

● Digital Boardroom

● Calendar

● Security
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● Connections

● System

4. Explore the following story, analytic applications, and modeler landing pages. If needed, 
use the ...More option.

●  Stories

●  Modeler

●  Analytic Applications

Result
When you select Stories from the navigation bar, the Welcome to Stories page opens. 
Here, you can create new stories and use templates.

When you select the Modeler, the Welcome to the Modeler page opens. Here you have 
multiple options for creating new models, dimensions, and currency tables.

When you select the Analytic Applications, the Welcome to Analytic Applications page 
opens. Here you have multiple options for creating Analytic Applications, Bookmarks, and 
Custom Widgets.

5. What are the various types of files?
Result
Files include stories, models, and other objects.

6. Return to the Home page.

7. Use the online help for the glossary, deployment, and create tasks.

8. Review the types of notifications the system can issue.
Result
Notification types include alerts, collaboration, and tasks.

9. From the Navigation Bar on the upper left, return to the Home page if needed.

Task 3: Use the Search to Insight Feature
Search to Insight is a natural language query interface used to query data.

Note:
Your results may vary from the instructions as there are multiple sources for 
Operating Expense data.

1. Use search to insight for Operating Income.
Result
Search to Insight opens and a waterfall chart for Operating Income is displayed. If you 

hover on the  symbol near the top left of the chart, it should display the source model: 

U00M_Op_Income (the model you get may vary)>

2. In the input field after Operating Income, input over Time and press Enter.

Unit 1: Getting started with SAP Analytics Cloud
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Result
A trend chart is generated. If you do not get any data, enter Quantity Sold by Date. If 
you receive a chart generation error, choose Other Results and select a different model 
such as SAP__FI_ANA_IM_GLFP.

Figure 1: Search for Insight Result

3. On the top left, choose Exit Search to Insight.

4. Close the new features banner.
Result
You have completed this exercise.

Exercise 1: Explore the SAP Analytics Cloud user interface
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Unit 1
Solution 1

Explore the SAP Analytics Cloud user interface

Business Example

You are new to SAP Analytics Cloud and so you need to learn how to use the Home page and 
perform a few navigation tasks.

Task Flow

In this exercise, you will perform the following tasks:

● Navigate the SAP Analytics Cloud user interface

● Use the Search to Insight feature

Task 1: Log on to SAP Analytics Cloud

1. Log on to SAP Analytics Cloud. Go to the next task if you are already logged in.

● User: A## or B##
## is your 2-digit group number, and the letter is what your instructor assigned to you.

● Password: Welcome1

If prompted, choose Accept in the Welcome dialog.
a) From your training remote desktop, launch Google Chrome.

b) Type (or copy/paste) the URL (provided by your instructor) for the SAP Analytics 
Cloud tenant you will use in class.

c) Your instructor has assigned you to a group, either A or B, and also given you a 2-digit 
group number. Log on to SAP Analytics Cloud using the credentials above.

d) If prompted, choose Accept in the Welcome dialog.

Task 2: Explore the SAP Analytics Cloud User Interface

1. Determine the current revision level of the SAP Analytics Cloud you are using. Use the 
help to access information regarding new features.

a) From the Navigation Bar on the left, go to  System → About.

A new pop-up window will open and show you the version of the training tenant. 
Choose OK to close the dialog.

b) On the upper right area of the Home Screen, choose the Help ? button. Choose What`s 
new and see the most recent new features. Choose Close to return to the Home page.

2. Open your user profile. Locate the log out option. Edit the User Preferences but do not 
change them.
a) Choose Profile on the upper right of the Home page (to the right of ?Help).
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b) Locate (but do not select) the Sign Out option.

c) Go to Profile Settings.

d) Choose  Edit to make the user preferences editable. View the possible languages in 
the dropdown menu.

e) Close the dialog.

3. Explore the Navigation Bar on the left side by selecting/expanding each of the following 
menu options. If needed, use the ...More option.

● Home

● Files

● Stories

● Analytic Applications

● Data Analyzer

● Digital Boardroom

● Calendar

● Security

● Connections

● System

4. Explore the following story, analytic applications, and modeler landing pages. If needed, 
use the ...More option.

●  Stories

●  Modeler

●  Analytic Applications

a) From the Navigation Bar choose the Stories, Modeler, and Analytic Applications icons 
to access the object-specific page.

Result
When you select Stories from the navigation bar, the Welcome to Stories page opens. 
Here, you can create new stories and use templates.

When you select the Modeler, the Welcome to the Modeler page opens. Here you have 
multiple options for creating new models, dimensions, and currency tables.

When you select the Analytic Applications, the Welcome to Analytic Applications page 
opens. Here you have multiple options for creating Analytic Applications, Bookmarks, and 
Custom Widgets.

5. What are the various types of files?

Solution 1: Explore the SAP Analytics Cloud user interface
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a) From the Navigation Bar choose Files.

b) Use the  Filter dropdown to see the types of files.

Result
Files include stories, models, and other objects.

6. Return to the Home page.

7. Use the online help for the glossary, deployment, and create tasks.
a) Choose the ? icon on the upper right.

b) Choose Help.

c) Type Glossary and press Enter.

d) Select the Glossary entry.

e) In the Search field, type Deployment and press Enter.

f) Search the help for Creating Tasks, and read about creating tasks.

g) Close the help dialog.

8. Review the types of notifications the system can issue.

a) To review the types of notifications the system can issue, choose the  Notifications 

icon on the upper right.

b) Choose the dropdown arrow next to All Types.

Result
Notification types include alerts, collaboration, and tasks.

9. From the Navigation Bar on the upper left, return to the Home page if needed.

Task 3: Use the Search to Insight Feature
Search to Insight is a natural language query interface used to query data.

Note:
Your results may vary from the instructions as there are multiple sources for 
Operating Expense data.

1. Use search to insight for Operating Income.
a) Under Hello, A## (or B##), enter Operating Income.

b) Press Enter.

Result
Search to Insight opens and a waterfall chart for Operating Income is displayed. If you 

hover on the  symbol near the top left of the chart, it should display the source model: 

U00M_Op_Income (the model you get may vary)>

2. In the input field after Operating Income, input over Time and press Enter.

Unit 1: Getting started with SAP Analytics Cloud
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Result
A trend chart is generated. If you do not get any data, enter Quantity Sold by Date. If 
you receive a chart generation error, choose Other Results and select a different model 
such as SAP__FI_ANA_IM_GLFP.

Figure 1: Search for Insight Result

3. On the top left, choose Exit Search to Insight.

4. Close the new features banner.
a) Near the top of the page, there is a banner that says: New features are available. Check 

them out.

b) On the right, choose x Close.

Result
You have completed this exercise.

Solution 1: Explore the SAP Analytics Cloud user interface
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Unit 1
Exercise 2

Use basic SAP Analytics Cloud story 
navigation

Business Example

You are new to SAP Analytics Cloud and so you need to learn how to use stories and perform 
a few navigation tasks.

Task Flow

In this exercise, you will perform the following tasks:

● Explore a story in view mode

● Copy an existing story for editing

● Rename a story

● Use the new story to analyze the data

Task 1: Log on to SAP Analytics Cloud

1. Log on to SAP Analytics Cloud. Go to the next task if you are already logged in.

● User: A## or B##.

## is your 2-digit group number, and the letter is what your instructor assigned to you.

● Password: Welcome1

Task 2: Explore a Sample Story in View Mode

1. From the Home page, choose Explore a Sample Story.
Result
The sample story opens to the Summary page, which includes a point/number chart, a 
bar chart, and a trend chart.

A story is a presentation-style document that uses charts, visualizations, text, and images 
to describe data.
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Figure 2: Sample Story

2. On the right, deselect Juices.

Result
All of the widgets (charts and tables) now exclude data for Juices.

3. Drill down on location in the average gross margin bar chart. Reset the story.

4. Use Smart Insights to see the key contributors for California in the average gross margin 
bar chart..

5. In the ribbon, locate the Display option (upper left). Use the dropdown next to Display and 
choose Tab Bar.
Result
Now the Summary, Analysis, and Sales Manager Overview pages appear as tabs.

6. Go to the Analysis page.
Result
A geo map and a scatterplot are available for analysis.

7. Switch the geo map to full screen mode.

8. In the Sales Manager Overview, deselect Juice and Others in the Product filter and use the 
Controls button to display them.
Result
The page filter should list Alcohol and Carbonated Drinks as selected products.

9. In the data table, exclude Nancy Miller and view the exclusion in Controls. Reset the story.

10. Return to the Home page via the Navigation Bar.

Task 3: Copy an Existing Story for Editing

1. Locate the  P00S_Calculations_Story story in the public folder for the SACE11 content.

2. Copy P00S_Calculations_Story to the My Files folder as follows:

Exercise 2: Use basic SAP Analytics Cloud story navigation
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Field Value

Name U##S_Calcs
Description U## Story Calculations

Result
The new story is saved to your My Files folder.

Task 4: Rename the Story

1. Use the Navigation Bar to access your  My Files area.

2. Rename the U##S_Calcs story as follows:

Name U##S_First_Story
Description U## First Story

Task 5: Use the New Story to Analyze the Data

1. Open the U##S_First_Story.

Note:
You should not be prompted to log on but if you are, try to  reload (directly 
above the SAP logo) the SAP Analytics Cloud browser. This story accesses 
data from live SAP HANA views and since single sign-on is enabled, you should 
not be prompted to log on.

2. Change from View mode to Edit Mode. Discover the differences.

Note:
If prompted to enable Optimized View Mode, choose No Thanks.

Result
In edit mode:

● The pages are automatically displayed.

● There are more options in the ribbon, such as those in the Data toolbar.

● The Story and Data buttons appear on the upper left.

● The Designer button appear on the upper right.

● The More option is available in the ribbon.

3. Use the Designer button for a table object.
Result
The Builder pane displays the Data Source, the Table Structure, Rows, Columns, and so 
on. On the upper right, you can use  Styling to format the table.

Unit 1: Getting started with SAP Analytics Cloud
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4. Perform a device preview for an iOS device and various sizes.
Result
Since this story uses responsive pages, it can be used for mobile devices that vary in size.

5. On the Financials page in View mode, filter on Juice and save a personal bookmark as 
U##_Juice. Make it your default.

6. Use the Navigation Bar to go back to Home screen.

7. Under Recent Stories, open U##S_First_Story. On the Financials page, only Juice should 
be displayed.

Figure 3: First Story - With the Bookmark for Juice

8. Export the story as a PDF.
Result
When you export a story, a PDF is created with a separate PDF page for each page in the 
story.

9. Return to the Home screen.

Exercise 2: Use basic SAP Analytics Cloud story navigation
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Unit 1
Solution 2

Use basic SAP Analytics Cloud story 
navigation

Business Example

You are new to SAP Analytics Cloud and so you need to learn how to use stories and perform 
a few navigation tasks.

Task Flow

In this exercise, you will perform the following tasks:

● Explore a story in view mode

● Copy an existing story for editing

● Rename a story

● Use the new story to analyze the data

Task 1: Log on to SAP Analytics Cloud

1. Log on to SAP Analytics Cloud. Go to the next task if you are already logged in.

● User: A## or B##.

## is your 2-digit group number, and the letter is what your instructor assigned to you.

● Password: Welcome1

a) From your training remote desktop, launch Google Chrome.

b) Enter the URL (provided by your instructor) for the SAP Analytics Cloud tenant you will 
use in class.

c) Your instructor has assigned you to a group, either A or B, and also given you a 2-digit 
group number. Log on to SAP Analytics Cloud using the credentials above.

Task 2: Explore a Sample Story in View Mode

1. From the Home page, choose Explore a Sample Story.
Result
The sample story opens to the Summary page, which includes a point/number chart, a 
bar chart, and a trend chart.

A story is a presentation-style document that uses charts, visualizations, text, and images 
to describe data.

© Copyright. All rights reserved. 12



Figure 2: Sample Story

2. On the right, deselect Juices.

Result
All of the widgets (charts and tables) now exclude data for Juices.

3. Drill down on location in the average gross margin bar chart. Reset the story.
a) In the Average gross margin chart, click the bar for California.

b) Click the drill down symbol .

Result
The cities in California are displayed.

c) In the ribbon, choose Edit →  Reset →  Reset.

4. Use Smart Insights to see the key contributors for California in the average gross margin 
bar chart..
a) In the Average gross margin chart, right click the bar for California.

b) Choose Smart Insights. Under How has this changed, expand the node to see an 
explanation and a bar chart.

c) On the lower right, choose Close.

5. In the ribbon, locate the Display option (upper left). Use the dropdown next to Display and 
choose Tab Bar.
Result
Now the Summary, Analysis, and Sales Manager Overview pages appear as tabs.

6. Go to the Analysis page.
Result
A geo map and a scatterplot are available for analysis.

7. Switch the geo map to full screen mode.
a) Select the geo map.

Solution 2: Use basic SAP Analytics Cloud story navigation
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b) Use the  More Actions icon and choose Fullscreen.

c) Exit full screen mode.

8. In the Sales Manager Overview, deselect Juice and Others in the Product filter and use the 
Controls button to display them.
a) Go to the Sales Manager Overview page.

b) On the left, deselect Juices and Others.

c) On the upper right, choose Controls to see what filters are applied.

d) On the lower right, choose Done to close the Controls panel.

Result
The page filter should list Alcohol and Carbonated Drinks as selected products.

9. In the data table, exclude Nancy Miller and view the exclusion in Controls. Reset the story.
a) In the data table, right click on Nancy Miller → Exclude.

b) On the upper right, choose Controls.
Result
The widget (table) filter should list the sales manager Nancy Miller as excluded.

c) On the lower right, choose Done to close the Controls panel.

d) In the ribbon, choose Edit →  Reset →  Reset.

10. Return to the Home page via the Navigation Bar.

Task 3: Copy an Existing Story for Editing

1. Locate the  P00S_Calculations_Story story in the public folder for the SACE11 content.

a) From the Navigation Bar choose  Files.

b) Go to Public → SACE11_34 → Content.

2. Copy P00S_Calculations_Story to the My Files folder as follows:

Field Value

Name U##S_Calcs
Description U## Story Calculations

a) Select the  P00S_Calculations_Story story.

b) Near the top of the page, choose  Copy To.

c) Choose My Files from the upper left corner of the dialog box.

d) Enter the information as shown in the preceding table.

e) Choose OK.

Unit 1: Getting started with SAP Analytics Cloud
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Result
The new story is saved to your My Files folder.

Task 4: Rename the Story

1. Use the Navigation Bar to access your  My Files area.

2. Rename the U##S_Calcs story as follows:

Name U##S_First_Story
Description U## First Story

a) Select the  U##S_Calcs story.

b) Choose  Edit Details.

c) Enter the data as provided.

d) Choose Save.

Task 5: Use the New Story to Analyze the Data

1. Open the U##S_First_Story.

Note:
You should not be prompted to log on but if you are, try to  reload (directly 
above the SAP logo) the SAP Analytics Cloud browser. This story accesses 
data from live SAP HANA views and since single sign-on is enabled, you should 
not be prompted to log on.

2. Change from View mode to Edit Mode. Discover the differences.

Note:
If prompted to enable Optimized View Mode, choose No Thanks.

a) On the upper right, choose Edit to get more story options.

Note:
If prompted to enable Optimized View Mode, choose No Thanks.

b) What are the differences?

Result
In edit mode:

● The pages are automatically displayed.

Solution 2: Use basic SAP Analytics Cloud story navigation

© Copyright. All rights reserved. 15



● There are more options in the ribbon, such as those in the Data toolbar.

● The Story and Data buttons appear on the upper left.

● The Designer button appear on the upper right.

● The More option is available in the ribbon.

3. Use the Designer button for a table object.
a) In the Shipping & Region page, click on the PACIFICA_SHIPPING_INFO table.

b) On the upper right, click the Designer button. The Builder pane opens for the table.

c) Click the Designer button to close the Builder pane.

Result
The Builder pane displays the Data Source, the Table Structure, Rows, Columns, and so 
on. On the upper right, you can use  Styling to format the table.

4. Perform a device preview for an iOS device and various sizes.
a) In the ribbon, use the . . . More option and choose Device Preview. Alternatively, 

depending on your screen size and resolution, choose the Device Preview button 

from the Format area of the toolbar.

b) Select the iOS Device and Large Tablet Size and then Small Phone.

c) Click  to exit the device preview.

Result
Since this story uses responsive pages, it can be used for mobile devices that vary in size.

5. On the Financials page in View mode, filter on Juice and save a personal bookmark as 
U##_Juice. Make it your default.

a) If necessary, click View in the upper right to get into View mode.

b) Use the scroll feature at the top of the page to access the Financials page.

c) In the column chart in the middle of the page, click on the column for Juice and select 

the filter symbol .

d) On the top left, select the Tools dropdown.

e) Choose Bookmark →  Bookmark Current State →  Enter a name of U##_Juice →  

Select Personal → Select Set as the new default view of this story.

6. Use the Navigation Bar to go back to Home screen.

7. Under Recent Stories, open U##S_First_Story. On the Financials page, only Juice should 
be displayed.

Unit 1: Getting started with SAP Analytics Cloud
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Figure 3: First Story - With the Bookmark for Juice

8. Export the story as a PDF.
a) Go to File →  Export.

b) For File Type, select PDF →  Export.

c) On the lower left, open the PDF and view the output.

d) Close the PDF.

Result
When you export a story, a PDF is created with a separate PDF page for each page in the 
story.

9. Return to the Home screen.

Solution 2: Use basic SAP Analytics Cloud story navigation
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Unit 1
Exercise 3

Share a story

Business Example
Business scenario: You are new to SAP Analytics Cloud and you need to learn how to work 
with some of SAP Analytics Cloud's sharing options.

Task Flow

In this exercise, you will perform the following tasks:

● Open an existing story

● Pin a widget to your Home page

● Share your story

1. Open your U##S_First_Story.

Note:
You should not be prompted to log on but if you are, try to  reload (directly 
above the SAP logo) the SAP Analytics Cloud browser. This story accesses 
data from live SAP HANA views and since single sign-on is enabled, you should 
not be prompted to log on.

2. Pin the Number of Orders KPI to your Home page.

3. Close the story by returning to the Home screen.

4. Share the story from your personal folder to your team (A or B). They should only have 
permission to see the story in View mode.

5. Delete the Number of Orders KPI from your Home Screen.
Result
By removing this KPI, you will not need to log into SAP HANA every time you access SAP 
Analytics Cloud in this course.

6. Unshare the story.

7. Return to the Home screen.
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Unit 1
Solution 3

Share a story

Business Example
Business scenario: You are new to SAP Analytics Cloud and you need to learn how to work 
with some of SAP Analytics Cloud's sharing options.

Task Flow

In this exercise, you will perform the following tasks:

● Open an existing story

● Pin a widget to your Home page

● Share your story

1. Open your U##S_First_Story.

Note:
You should not be prompted to log on but if you are, try to  reload (directly 
above the SAP logo) the SAP Analytics Cloud browser. This story accesses 
data from live SAP HANA views and since single sign-on is enabled, you should 
not be prompted to log on.

2. Pin the Number of Orders KPI to your Home page.
a) Select the # of Orders KPI (on the upper left).

b) Choose the More Actions icon and choose Pin to Home. If prompted to save the story, 
do so.

3. Close the story by returning to the Home screen.

4. Share the story from your personal folder to your team (A or B). They should only have 
permission to see the story in View mode.

a) Open the  Navigation Bar if needed. On the top left, choose Files.

b) Select your story U##S_First_Story.

c) To use the share function, choose the  icon.

d) Select Share.

e) In the pop-up window, choose enter Team_A (or B depending on what group your class 
is using) and choose OK.

f) The access should be set to View.
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g) Choose Share and then choose Close.

5. Delete the Number of Orders KPI from your Home Screen.
a) Select the Number of Orders KPI.

b) Choose . . . Tile Settings and then Delete →  OK.

Result
By removing this KPI, you will not need to log into SAP HANA every time you access SAP 
Analytics Cloud in this course.

6. Unshare the story.

a) Open the  Navigation Bar if needed. On the top left, choose Files.

b) Select your  U##S_First_Story story.

c) Choose the  icon.

d) Select Share.

e) Expand Share with 1 Team.

f) Select the Team and Unshare the story.

g) Choose Close.

7. Return to the Home screen.

Unit 1: Getting started with SAP Analytics Cloud

© Copyright. All rights reserved. 20



Unit 2
Exercise 4

Use Data Analyzer to create an insight

Access Live Data with the Data Analyzer

Business Example

You need to know how to access data from a source system without performing a data 
import. With the data analyzer, you have a quick and easy way to access data via live 
connections. The result can be captured in a data analyzer insight.

Task Flow
● Access Live Data with the Data Analyzer from SAP Business Warehouse

● Access Live Data with the Data Analyzer from SAP HANA

1. Log on to SAP Analytics Cloud. Go to the next step if you are already logged in.

● User: A## or B##.

## is your 2-digit group number, and the letter is what your instructor assigned to you.

● Password: Welcome1

2. Create a Data Analyzer Insight based in SAP Business Warehouse data.

Field Value

System Type: SAP BW

Connection: A4H

Datasource: P00Q_BW_Q_STRUCTURES

Result
After a few seconds, the data appears with measures in the columns and location and a 
structure in the rows.

3. Configure the Insight as follows:

Field Value

Rows Region

Structure

Columns Sales_Value

Quantity

4. Save the insight as follows:

Field Value

Name U##I_BW
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Field Value

Description U## BW Insight

 Automatically open prompt when in-
sight opens (under Advanced Options)

Result
You have created an insight based on an SAP BW Query.

5. Create a Data Analyzer Insight based on SAP HANA data.

Field Value

System Type: SAP HANA

Connection: RemoteCO

Datasource: WORKSHOP_PACIFICA_ORDER_FINANCE

Result
After a few seconds, the data appears with Price in the columns but nothing in the rows.

6. Configure the Insight as follows:

Field Value

Rows Region
Location

Columns Measures:  Select All

Result
You have created an insight based on an SAP HANA calculation view.

7. Save the insight as follows:

Field Value

Name U##I_HANA
Description U## HANA Insight

Unit 2: Establishing data sources and connections
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Result

You have created an insight based on an SAP S/4HANA core data services view.

8. Return to the Home page.
Result
You have completed this exercise.

Exercise 4: Use Data Analyzer to create an insight
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Unit 2
Solution 4

Use Data Analyzer to create an insight

Access Live Data with the Data Analyzer

Business Example

You need to know how to access data from a source system without performing a data 
import. With the data analyzer, you have a quick and easy way to access data via live 
connections. The result can be captured in a data analyzer insight.

Task Flow
● Access Live Data with the Data Analyzer from SAP Business Warehouse

● Access Live Data with the Data Analyzer from SAP HANA

1. Log on to SAP Analytics Cloud. Go to the next step if you are already logged in.

● User: A## or B##.

## is your 2-digit group number, and the letter is what your instructor assigned to you.

● Password: Welcome1

a) From your training remote desktop, launch Google Chrome.

b) Enter the URL (provided by your instructor) for the SAP Analytics Cloud tenant you will 
use in class.

c) Your instructor has assigned you to a group, either A or B, and also given you a 2-digit 
group number. Log on to SAP Analytics Cloud using the credentials above.

2. Create a Data Analyzer Insight based in SAP Business Warehouse data.

Field Value

System Type: SAP BW

Connection: A4H

Datasource: P00Q_BW_Q_STRUCTURES

a) In the navigation area on the left, choose  Data Analyzer.

b) Choose From a Data Source.

c) In the Select Data Source dialog, make your selections as shown in the table above.

d) Choose OK.

Result
After a few seconds, the data appears with measures in the columns and location and a 
structure in the rows.
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3. Configure the Insight as follows:

Field Value

Rows Region

Structure

Columns Sales_Value

Quantity

a) On the upper right, choose the  Builder button in order to open the Builder and 

Available Items panels.

b) Remove Location from the rows.

c) Drag Region into the Rows above the Structure.

4. Save the insight as follows:

Field Value

Name U##I_BW
Description U## BW Insight

 Automatically open prompt when in-
sight opens (under Advanced Options)

a) On the upper left, choose Save.

b) Enter the data as provided.

c) Choose OK.

Result
You have created an insight based on an SAP BW Query.

5. Create a Data Analyzer Insight based on SAP HANA data.

Field Value

System Type: SAP HANA

Connection: RemoteCO

Datasource: WORKSHOP_PACIFICA_ORDER_FINANCE

a) In the navigation area on the left, choose  Data Analyzer.

b) Choose From a Data Source.

c) In the Select Data Source dialog, make your selections as shown in the table above.

d) Choose OK.

Result
After a few seconds, the data appears with Price in the columns but nothing in the rows.

Solution 4: Use Data Analyzer to create an insight
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6. Configure the Insight as follows:

Field Value

Rows Region
Location

Columns Measures:  Select All

a) On the upper right, choose the  Builder button in order to open the Builder and 

Available Items panels.

b) Configure the insight as shown above.

Result
You have created an insight based on an SAP HANA calculation view.

7. Save the insight as follows:

Field Value

Name U##I_HANA
Description U## HANA Insight

a) On the upper left, choose Save.

b) Enter the data as provided.

c) Choose OK.

Result

You have created an insight based on an SAP S/4HANA core data services view.

8. Return to the Home page.
Result
You have completed this exercise.

Unit 2: Establishing data sources and connections
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Unit 3
Exercise 5

Create a live data model based on SAP HANA 
data

Business Example

You need to access real time data from your SAP HANA on premise system for simple data 
analysis.

Task Flow

In order to do this, perform the following steps:

● Create a live data model in SAP Analytics Cloud

● Connect to an SAP HANA on premise system and select a calculation view

● Select order date as the time dimension

● View the data in data analyzer

Task 1: Log on to SAP Analytics Cloud

1. If necessary, log on to SAP Analytics Cloud. If you are already logged in, go to the next 
task.

Username: A## or B##, where ## is your 2-digit group number, and the letter is what 
your instructor assigned to you.

Password: Welcome1

Task 2: Create a live data model in SAP Analytics Cloud

1. Create a Live Data Model as follows:

Field Value

System Type SAP HANA
Connection RemoteCO
Data Source WORKSHOP_PACIFICA_ORDER_FINANCE

Several measures are displayed. WORKSHOP_PACIFICA_ORDER_FINANCE is a calculation 
view in the underlying SAP HANA system.

2. View the dimensions.
Result
There are several time related dimensions as well as product, store, and order related 
dimensions.
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3. Create two groupings as follows:

Table 1:

Dimension Group

ORDER_&_DATE_ID Orders
Order_Number Orders
Order_Date_and_Time Orders
Product Product & Sales
Product_Category Product & Sales
Store Product & Sales
Sales_Manager Product & Sales
Location Product & Sales
Region Product & Sales
Order_Date Orders
Order_Time Orders

4. Configure Order Date as the time dimension as follows:

Field Value

Dimension Order_Date (Order Date)
Time View DayGranularity

Field in Time View DATE(Date)

Default Hierarchy YHM(Year, Half-Year, Month)

Result
You have mapped the SAP Analytics Cloud time dimension to the SAP HANA time field. 
Now, you will be able to select various SAP Analytics Cloud time hierarchies and use 
automatic time determination.

5. Save the model as follows:

Field Value

Name U##M_HANA_Live_Model
Description U##M HANA Finance Data

Task 3: View the data in Data Analyzer

1. Launch Data Analyzer from the model.

2. Configure the Insight as follows:

Rows: Order_Date_DATE

Unit 3: Using modeling
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Columns:

Measures Sales Revenue

Gross Margin

Order_Date_DATE drill level 4

Result
Because Order_Date_DATE is a time dimension, the system-provided time hierarchy is 
available for use.

3. Set the number of decimals to zero for Sales Revenue.
Result

4. Save the Insight by using the ribbon or pressing Ctrl+S.

Field Value

Name U##I_HANA_LIVE
Description U## HANA Live Insight

5. Return to the Home page.
Result
You have completed this exercise.

Exercise 5: Create a live data model based on SAP HANA data
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Unit 3
Solution 5

Create a live data model based on SAP HANA 
data

Business Example

You need to access real time data from your SAP HANA on premise system for simple data 
analysis.

Task Flow

In order to do this, perform the following steps:

● Create a live data model in SAP Analytics Cloud

● Connect to an SAP HANA on premise system and select a calculation view

● Select order date as the time dimension

● View the data in data analyzer

Task 1: Log on to SAP Analytics Cloud

1. If necessary, log on to SAP Analytics Cloud. If you are already logged in, go to the next 
task.

Username: A## or B##, where ## is your 2-digit group number, and the letter is what 
your instructor assigned to you.

Password: Welcome1

a) From your training remote desktop, launch Google Chrome.

b) Type the URL (provided by your instructor) for the SAP Analytics Cloud Tenant you will 
use in class.

c) Your instructor has assigned you to a group, either A or B, and also given you a 2-digit 
group number. Log on to SAP Analytics Cloud using the provided credentials.

Task 2: Create a live data model in SAP Analytics Cloud

1. Create a Live Data Model as follows:

Field Value

System Type SAP HANA
Connection RemoteCO
Data Source WORKSHOP_PACIFICA_ORDER_FINANCE
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a) From the Navigation Bar choose  Modeler(or use the ...More option) and then 

choose Live Data Model in the Create New area.

b) Make the selections as shown in the table above.

c) Choose OK.

Several measures are displayed. WORKSHOP_PACIFICA_ORDER_FINANCE is a calculation 
view in the underlying SAP HANA system.

2. View the dimensions.
a) In the ribbon, choose All Dimensions.

Result
There are several time related dimensions as well as product, store, and order related 
dimensions.

3. Create two groupings as follows:

Table 1:

Dimension Group

ORDER_&_DATE_ID Orders
Order_Number Orders
Order_Date_and_Time Orders
Product Product & Sales
Product_Category Product & Sales
Store Product & Sales
Sales_Manager Product & Sales
Location Product & Sales
Region Product & Sales
Order_Date Orders
Order_Time Orders

a) Enter the groups as shown in the table above.

b) In the story or analytic application, the dimensions will now be contained in two logical 
groups for ease of access.

4. Configure Order Date as the time dimension as follows:

Field Value

Dimension Order_Date (Order Date)
Time View DayGranularity

Field in Time View DATE(Date)

Solution 5: Create a live data model based on SAP HANA data

© Copyright. All rights reserved. 31



Field Value

Default Hierarchy YHM(Year, Half-Year, Month)

a) Choose  Create Time Dimension.

b) In the Maintain Time Dimensions dialog, choose + Add.

c) Configure as shown above.

d) Choose Add → OK.

Result
You have mapped the SAP Analytics Cloud time dimension to the SAP HANA time field. 
Now, you will be able to select various SAP Analytics Cloud time hierarchies and use 
automatic time determination.

5. Save the model as follows:

Field Value

Name U##M_HANA_Live_Model
Description U##M HANA Finance Data

a) Choose Save.

b) Enter the data provided above.

c) Choose Save twice if needed.

d) Stay in the model.

Task 3: View the data in Data Analyzer

1. Launch Data Analyzer from the model.

a) In the ribbon, choose .

b) Use the dropdown to select Data Analyzer.

2. Configure the Insight as follows:

Rows: Order_Date_DATE

Columns:

Measures Sales Revenue

Gross Margin

Order_Date_DATE drill level 4

a) On the upper right, choose the  Builder button in order to open the Builder and 

Available Items panels.

b) Drag Order_Date_DATE into the Rows.

Unit 3: Using modeling
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c) In the Builder pane, choose … More for the Order_Date_DATE dimension and select the 
Year, Quarter, Month hierarchy. Choose OK.

d) To set the drill level for Order_Date_DATE, in the Builder pane of the Builder pane, 
choose … More for the Order_Date_DATE dimension → Drill →  Level 4.

Result
Because Order_Date_DATE is a time dimension, the system-provided time hierarchy is 
available for use.

3. Set the number of decimals to zero for Sales Revenue.

a) On the right, go to  Styling.

b) Select the Sales Revenue column header in the table.

c) In the Styling pane on the right, set the Decimal Places to 0.

Result

4. Save the Insight by using the ribbon or pressing Ctrl+S.

Field Value

Name U##I_HANA_LIVE
Description U## HANA Live Insight

a) Choose Save.

b) Enter the data as provided above.

c) Choose OK.

5. Return to the Home page.
Result
You have completed this exercise.

Solution 5: Create a live data model based on SAP HANA data
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Unit 4
Exercise 6

Create visualizations for a story

You need to create a story containing charts on a responsive page.

1. Create a new optimized story with a responsive page.

2. Name the left lane as Revenue by Location.

3. Name the right lane as Revenue by Product.

4. Add a bar chart to the left lane with the P00M_Pacifica_Order_Finance model as a data 
source.

5. Add the Sales Revenue measure.

6. Add the Location dimension.

7. Enlarge the chart so that if fills most of the left lane.

8. Add a chart to the right lane with the P00M_Pacifica_Order_Finance model as a data 
source.

9. Change the chart type to Tree Map.

10. Add the Sales Revenue measure.

11. Add the Product dimension.

12. Close the Builder pane.

13. Enlarge the tree map chart so that if fills most of the right lane.

14. Save the story as follows:

Table 2:

Field Value

Name U##S_Visualizations
Description U## Visualizations Story
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Result

15. Return to the Home page.
Result
You have completed this exercise.

Exercise 6: Create visualizations for a story
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Unit 4
Solution 6

Create visualizations for a story

You need to create a story containing charts on a responsive page.

1. Create a new optimized story with a responsive page.

a) In the Navigation Bar, choose  Stories.

b) Choose Responsive.

c) Confirm that Optimized Design Experience is selected.

d) Choose Create.

2. Name the left lane as Revenue by Location.

a) In the left lane, choose Click to enter title.

b) Enter Revenue by Location.

3. Name the right lane as Revenue by Product.

a) In the right lane, choose Click to enter title.

b) Enter Revenue by Product.

4. Add a bar chart to the left lane with the P00M_Pacifica_Order_Finance model as a data 
source.
a) Click in the left lane.

b) In the ribbon, click the  chart icon. (You may need to use the . . . More option in the 
menu.)

c) Select a Dataset or Model: Choose Public → SACE11_34 → Content and select 
P00M_Pacifica_Order_Finance.

5. Add the Sales Revenue measure.
a) In the Builder pane on the right, choose +At Least 1 Measure Required.

b) Select Sales Revenue.

6. Add the Location dimension.
a) Choose +Add Dimension.

b) Select Location.

7. Enlarge the chart so that if fills most of the left lane.

8. Add a chart to the right lane with the P00M_Pacifica_Order_Finance model as a data 
source.
a) Click in the right lane.

b) In the ribbon, click the chart icon.
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9. Change the chart type to Tree Map.
a) Under Currently Selected Chart, chooseBar/Column.

b) Select Tree Map.

10. Add the Sales Revenue measure.
a) In the Builder pane on the right, choose +At Least 1 Measure Required.

b) Select Sales Revenue.

11. Add the Product dimension.
a) Choose +At Least 1 Dimension Required.

b) Select Product.

12. Close the Builder pane.
a) On the upper right, choose the Designer button.

b) The Builder pane should be closed.

13. Enlarge the tree map chart so that if fills most of the right lane.

14. Save the story as follows:

Table 2:

Field Value

Name U##S_Visualizations
Description U## Visualizations Story

a) Choose Save in the ribbon or press Ctrl+S.

b) Enter the data from the table above.

c) Choose OK.

Result

15. Return to the Home page.
Result
You have completed this exercise.

Solution 6: Create visualizations for a story
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Unit 4
Exercise 7

Build a simple analytic application

Business Example

You are an advanced business user of SAP Analytics Cloud. You want to create a dashboard 
to provide management with an overview of the sales revenue for different regions. You want 
to analyze the data in a chart or a table format and filter the results based on different product 
categories.

Task Flow

In this exercise, you will perform the following tasks:

● Create an analytic application

● Add a table and chart

● Configure a radio button with script to display either the chart or the table

● Set up a dropdown widget that uses loops through an array to display products

1. Log on to SAP Analytics Cloud.

● User: A## or B##.

## is your 2-digit group number, and the letter is what your instructor assigned to you.

● Password: Welcome1

2. Open the Home screen.

Task 1: Create an analytic application

1. Create a new analytic application.

2. Insert a Clock widget to the Canvas, remove the logo, and resize the clock widget.

Task 2: Add a table and chart

1. Insert a table and connect it to the P00M_Pacifica_Order_Finance model. In Rows, use the 
Region dimension. In Columns, use the Sales Revenue measure.

2. Insert a column chart using the P00M_Pacifica_Order_Finance model. Use Region as the 
Dimension. Use Sales Revenue as the Measure.

3. Save the application as follows:

Field Value

Name U##AD_Finance
Description U## Finance Application
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4. Run the Analytical Application and edit the run mode. NOTE: Ignore any messages 
regarding allowing pop-ups.
Result

In Present mode, a toolbar  is visible. 

The toolbar is used to refresh the application, edit prompts, or switch to full screen.

5. Close the extra Chrome tab.

Task 3: Configure a radio button

1. In design mode, add a radio button group component as follows:

Figure 4: Radio Button Group

2. Format the radio button group with a light gray background and all borders.

3. Set the table to be hidden at view time.

4. Position the chart so that it is directly on top of the table. Resize the table and chart if 
necessary to ensure they are the same size.

5. Add the following script to the onSelect() function of the radio button group:
/* We use triple equals "===" for comparison because SAP Analytics 
Cloud Analytics Designer has no automatic type casting. With triple 
equals, both the value and type must be the same for the result to be 
# true. The triple equals is known as the strict equality comparison 
operator.*/

if (RadioButtonGroup_1.getSelectedKey() === "Chart") { 
    Chart_1.setVisible(true); 
    Table_1.setVisible(false); 
} else { 
    Chart_1.setVisible(false); 
    Table_1.setVisible(true); 
}

Exercise 7: Build a simple analytic application
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Result

Figure 5: Analytic Designer

6. Save the changes to your application.

7. Run the application and switch between the table and chart with the radio buttons.

Note:
If the radio button group is not visible, check its Styling options to make sure 
Show this item at view time is selected. (You want to see it at view time.)

Task 4: Set up a dropdown widget

1. Add a dropdown widget and text widget above it. Enter the text: Category.

2. Add the following code to the Canvas onInitialization event:
 /* The script uses the datasource of the Table and reads the members 
of the Product Category dimension and adds them to an array. We later 
loop through the array, read the dimension members and populate the 
Dropdown */

var categories = 
Table_1.getDataSource().getMembers("Product_Category");
for (var counter = 0; counter < categories.length; ++counter) {
     Dropdown_1.addItem(categories[counter].id, 
categories[counter].description); 
}

Result
The code will populate the dropdown with product categories from the datasource when 
the application opened.

3. Add the following code to the dropdown component:
/* The value from the dropdown is read and used to set a dimension 
filter for both the chart and the table. */

Unit 4: Using stories and analytic applications
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var selected_category = Dropdown_1.getSelectedKey();
Chart_1.getDataSource().setDimensionFilter("Product_Category", 
selected_category);
Table_1.getDataSource().setDimensionFilter("Product_Category", 
selected_category); 

Result
The dropdown will filter the chart and table on the selected product category.

4. Choose Save.

5. Run the application. Filter on the Juice product category. Note: Ignore any messages 
regarding allowing pop-ups.
Result

Figure 6: Analytic Application - Result

6. Return to the Home page.
Result
You have completed this exercise.

Exercise 7: Build a simple analytic application
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Unit 4
Solution 7

Build a simple analytic application

Business Example

You are an advanced business user of SAP Analytics Cloud. You want to create a dashboard 
to provide management with an overview of the sales revenue for different regions. You want 
to analyze the data in a chart or a table format and filter the results based on different product 
categories.

Task Flow

In this exercise, you will perform the following tasks:

● Create an analytic application

● Add a table and chart

● Configure a radio button with script to display either the chart or the table

● Set up a dropdown widget that uses loops through an array to display products

1. Log on to SAP Analytics Cloud.

● User: A## or B##.

## is your 2-digit group number, and the letter is what your instructor assigned to you.

● Password: Welcome1

a) From your training remote desktop, launch Google Chrome.

b) Enter the URL (provided by your instructor) for the SAP Analytics Cloud tenant you will 
use in class.

c) Your instructor has assigned you to a group, either A or B, and also given you a 2-digit 
group number. Log on to SAP Analytics Cloud using the credentials provided.

2. Open the Home screen.

Task 1: Create an analytic application

1. Create a new analytic application.

a) From the Navigation Bar choose  Analytic Applications.

b) Under Create New, choose the Application card.

2. Insert a Clock widget to the Canvas, remove the logo, and resize the clock widget.
a) From the menu bar, choose + →  More Widgets →  Clock.

b) Choose Designer and toggle off the Show Logo property.

c) Resize the Clock to make it smaller and position it on the top-left of the Canvas page.
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Task 2: Add a table and chart

1. Insert a table and connect it to the P00M_Pacifica_Order_Finance model. In Rows, use the 
Region dimension. In Columns, use the Sales Revenue measure.

a) From the Insert portion of the menu bar, choose .

b) In the Select Model box, choose Select other model ....

c) Go to Public →  SACE11_34 →  Content and choose the P00M_Pacifica_Order_Finance 
model.

d) From the Builder panel, add the Region dimension to Rows.

e) Under Columns, choose  Manage Filters next to Measures and choose only the 

Sales Revenue measure.

f) Position the table below the clock.

2. Insert a column chart using the P00M_Pacifica_Order_Finance model. Use Region as the 
Dimension. Use Sales Revenue as the Measure.

a) In the menu bar, choose .

b) From the Builder panel, choose Add Measure and choose Sales Revenue.

c) Choose Add Dimension and choose Region.

d) Position the chart next to the table.

3. Save the application as follows:

Field Value

Name U##AD_Finance
Description U## Finance Application

4. Run the Analytical Application and edit the run mode. NOTE: Ignore any messages 
regarding allowing pop-ups.
a) On the upper right, choose Run Analytic Application. NOTE: Ignore any messages 

regarding allowing pop-ups.

b) By default, the application runs in Present mode.

c) Hover near the top of the screen to see the toolbar.

Result

In Present mode, a toolbar  is visible. 

The toolbar is used to refresh the application, edit prompts, or switch to full screen.

5. Close the extra Chrome tab.

Task 3: Configure a radio button

1. In design mode, add a radio button group component as follows:

Solution 7: Build a simple analytic application
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Figure 4: Radio Button Group

a) Return to the Analytic Designer.

b) From the Insert portion of the menu bar, choose +Add → Radio Button Group.

c) In the Builder panel, edit the Radio Button ID values to Chart and Table. Select Chart as 
the default value.

d) Position the radio button group to the right of the chart, and resize if necessary.

2. Format the radio button group with a light gray background and all borders.

3. Set the table to be hidden at view time.
a) Select the table and in the Styling pane on the right, scroll to Actions.

b) Deselect  Show this item at view time.

4. Position the chart so that it is directly on top of the table. Resize the table and chart if 
necessary to ensure they are the same size.

5. Add the following script to the onSelect() function of the radio button group:
/* We use triple equals "===" for comparison because SAP Analytics 
Cloud Analytics Designer has no automatic type casting. With triple 
equals, both the value and type must be the same for the result to be 
# true. The triple equals is known as the strict equality comparison 
operator.*/

if (RadioButtonGroup_1.getSelectedKey() === "Chart") { 
    Chart_1.setVisible(true); 
    Table_1.setVisible(false); 
} else { 
    Chart_1.setVisible(false); 
    Table_1.setVisible(true); 
}

a) Locate the RadioButtonGroup_1 on the upper left.

b) Hover on RadioButtonGroup_1, and choose  to open the script editor.

c) In row 1, add the script provided above.

Unit 4: Using stories and analytic applications
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Result

Figure 5: Analytic Designer

6. Save the changes to your application.

7. Run the application and switch between the table and chart with the radio buttons.

Note:
If the radio button group is not visible, check its Styling options to make sure 
Show this item at view time is selected. (You want to see it at view time.)

a) From the menu, choose Run Analytic Application.

b) Use the radio button to dynamically switch between table or chart.

c) Return to the Analytic Designer.

Task 4: Set up a dropdown widget

1. Add a dropdown widget and text widget above it. Enter the text: Category.

a) From the Insert portion of the menu bar, choose + and insert a dropdown.

b) From the Insert portion of the menu bar, choose + and insert a text widget.

c) Position the drop down next to the radio button group, and place the text box directly 
above the dropdown box.

d) Place the cursor inside the text box and enter Category, which will serve as a label for 
the dropdown.

2. Add the following code to the Canvas onInitialization event:
 /* The script uses the datasource of the Table and reads the members 
of the Product Category dimension and adds them to an array. We later 
loop through the array, read the dimension members and populate the 
Dropdown */

var categories = 
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Table_1.getDataSource().getMembers("Product_Category");
for (var counter = 0; counter < categories.length; ++counter) {
     Dropdown_1.addItem(categories[counter].id, 
categories[counter].description); 
}

a) On the upper left, choose  Edit Scripts next to Canvas. Select onInitialization.

b) Add the above script in row 1.

Result
The code will populate the dropdown with product categories from the datasource when 
the application opened.

3. Add the following code to the dropdown component:
/* The value from the dropdown is read and used to set a dimension 
filter for both the chart and the table. */

var selected_category = Dropdown_1.getSelectedKey();
Chart_1.getDataSource().setDimensionFilter("Product_Category", 
selected_category);
Table_1.getDataSource().setDimensionFilter("Product_Category", 
selected_category); 

a) Choose  next to Dropdown_1.

b) Add the code above into row 1.

Result
The dropdown will filter the chart and table on the selected product category.

4. Choose Save.

5. Run the application. Filter on the Juice product category. Note: Ignore any messages 
regarding allowing pop-ups.
Result

Figure 6: Analytic Application - Result

6. Return to the Home page.
Result
You have completed this exercise.
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Unit 5
Exercise 8

Perform manual input planning

Task Flow

In this exercise, you will perform the following planning activities:

● Create a new model and a new story

● Input data at the parent level

● Use simulation features

● Work with private data and publish it

● Lock cells

Note:
In this exercise, when a value or object name includes ##, replace ## with the 
number that your instructor assigned to you.

Task 1: Create a New Model

1. Access the P00M_Op_Income planning model in the public folder for SACE11 content.

On the upper left, navigate to  Browse →  Files  →  Public  →  SACE11_34 →  Content.

2. Copy the P00M_Op_Income planning model and its data to My Files as follows:

Name U##M_Op_Income
Description U## Operating Income

 Include data

Task 2: Create a New Story

1. Create a new story.

2. Add a canvas page. When prompted to select a design mode type, choose Optimized 
Design Experience.

3. Add a table to the page based on the U##M_Op_Income model.

4. Rename the page to Income Statement Planning.

5. Save the story to the My Files folder as follows:

Name U##S_IS_Plan
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Description U##S Income Statement Planning

Task 3: Configure the Data Table

1. In the Builder pane on the right, set the Filter values as follows:

Dimension Member Value

Date (Member) 2020
Entity United States

Account Operating Income (use the search )

Version Actual and Forecast (not Pub_Forecast)

2. Expand the Account dimension to level 6.

3. Expand the table if necessary.
Result
Operating Income is around 860 for Actual and 164 for Forecast.

4. Add a percentage variance column.

5. Save the story by pressing Ctrl+S.

Task 4: Work with the Data Simulation Features

1. Create a private version as follows:

Field Value

Version Name PrivateData
Category Forecast

 Copy all data

Result
A new column is added for PrivateData.

2. Change the Gross Revenue PrivateData to 2500 and then use the undo data change 
feature.
Result
The original values appear.

3. Redo the data change and then view the history. Choose the data corresponding to the 
copy to the private version.
Result
The original data appears.

4. Change the Forecast Gross Revenue to 2400 and then revert it.

Result
Since the forecast version is public data, you can revert it.

Unit 5: Using planning
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Task 5: Use the Disaggregation Feature

1. Change the Cost of Goods Sold private data to 1000. What happened to the values for the 
children of the Cost of Goods Sold parent account?

2. Undo the data change.

3. Use the More menu (or choose  Refresh from the ribbon) to refresh the data so that 

the cells are not shaded in yellow.

4. Lock the cell for the Labor private data and see what happens when Cost of Goods Sold is 
changed again.
Result
Children accounts for Cost of Goods Sold are changed proportionately, except for Labor. 
The changed cells are shaded in yellow.

5. Unlock the Labor private data and increase it by 100 so that Cost of Goods Sold becomes 
1100.

Task 6: Publish the Private Data
You are satisfied with the Cost of Goods Sold private data value of 1100 and you would like to 
incorporate it into the Forecast data.

1. Publish the PrivateData as Forecast.
Result
Cost of Goods Sold for the Forecast version is now 1100. The PrivateData column is gone.

2. Save the story and return to the Home page.

Exercise 8: Perform manual input planning

© Copyright. All rights reserved. 49



Unit 5
Solution 8

Perform manual input planning

Task Flow

In this exercise, you will perform the following planning activities:

● Create a new model and a new story

● Input data at the parent level

● Use simulation features

● Work with private data and publish it

● Lock cells

Note:
In this exercise, when a value or object name includes ##, replace ## with the 
number that your instructor assigned to you.

Task 1: Create a New Model

1. Access the P00M_Op_Income planning model in the public folder for SACE11 content.

On the upper left, navigate to  Browse →  Files  →  Public  →  SACE11_34 →  Content.

2. Copy the P00M_Op_Income planning model and its data to My Files as follows:

Name U##M_Op_Income
Description U## Operating Income

 Include data

a) Select the P00M_Op_Income planning model.

b) Near the top of the page, choose  Copy To.

c) Choose My Files from the upper left corner of the dialog box and enter the information 
as shown in the preceding table.

d) Choose OK.

Task 2: Create a New Story

1. Create a new story.

a) From the Navigation Bar choose Stories.
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2. Add a canvas page. When prompted to select a design mode type, choose Optimized 
Design Experience.

3. Add a table to the page based on the U##M_Op_Income model.
a) Choose Table to add it to the page.

b) Select the U##M_Op_Income model.

4. Rename the page to Income Statement Planning.

a) Choose the dropdown arrow for Page 1 and choose Rename.

b) Enter the new name for the page and choose Rename.

5. Save the story to the My Files folder as follows:

Name U##S_IS_Plan
Description U##S Income Statement Planning

a) Press Ctrl+S.

b) Enter the details as shown in the table above and choose OK.

Task 3: Configure the Data Table

1. In the Builder pane on the right, set the Filter values as follows:

Dimension Member Value

Date (Member) 2020
Entity United States

Account Operating Income (use the search )

Version Actual and Forecast (not Pub_Forecast)

a) In the Builder pane, choose +Add Filters to add a new dimension to the filter.

b) Set the filter values according to the table above.

c) Select both Actual and Forecast (the full technical name for Forecast may appear as 
Public.Forecast-Forecast).

2. Expand the Account dimension to level 6.
a) In the table, right-click on Account → Choose Drill.

b) Select Level 6.

3. Expand the table if necessary.
Result
Operating Income is around 860 for Actual and 164 for Forecast.

4. Add a percentage variance column.
a) Highlight both column headers: Actual and Forecast.

b) Right-click and selelct Add Calculation →  Percentage Difference →  Single.

5. Save the story by pressing Ctrl+S.

Solution 8: Perform manual input planning
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Task 4: Work with the Data Simulation Features

1. Create a private version as follows:

Field Value

Version Name PrivateData
Category Forecast

 Copy all data

a) Right-click in the Forecast column and choose Version →  Copy Version.

b) Enter the data from above.

c) Choose OK.

Result
A new column is added for PrivateData.

2. Change the Gross Revenue PrivateData to 2500 and then use the undo data change 
feature.
a) For Gross Revenue and PrivateData, type 2500 and press Enter.

b) Right-click and choose Version → Undo Data Change.

Result
The original values appear.

3. Redo the data change and then view the history. Choose the data corresponding to the 
copy to the private version.
a) Right-click and choose Version →  Redo Data Change.

b) Right-click and choose Version →  History.
Result
The Version History appears on the right. 2500000000 is displayed as the current 
data (2500 Million), and below that the Copy to a Private Version is displayed.

c) Choose Copy to a Private Version.

Result
The original data appears.

4. Change the Forecast Gross Revenue to 2400 and then revert it.

a) Input 2400 for Forecast Gross Revenue.

b) Right-click and choose Version →  Revert.

c) Choose OK when prompted about the impact to the public data.

Result
Since the forecast version is public data, you can revert it.

Unit 5: Using planning
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Task 5: Use the Disaggregation Feature

1. Change the Cost of Goods Sold private data to 1000. What happened to the values for the 
children of the Cost of Goods Sold parent account?
a) Click on the Cost of Goods Sold data cell in the PrivateData version and type 1000. 

Press Enter.
Result
Raw material, labor, and so on are all changed proportionately. The changed cells are 
shaded in yellow.

2. Undo the data change.
a) Right-click in the PrivateData column.

b) Choose Version →  Undo Data Change.

3. Use the More menu (or choose  Refresh from the ribbon) to refresh the data so that 

the cells are not shaded in yellow.

4. Lock the cell for the Labor private data and see what happens when Cost of Goods Sold is 
changed again.
a) Right-click on the cell for Labor and PrivateData and choose Lock Cell.

b) Change the Cost of Goods Sold PrivateData to 1000.

Result
Children accounts for Cost of Goods Sold are changed proportionately, except for Labor. 
The changed cells are shaded in yellow.

5. Unlock the Labor private data and increase it by 100 so that Cost of Goods Sold becomes 
1100.
a) Right-click the cell and choose Lock Cell again. The value is no longer shaded.

b) Click the cell for the Labor private data and type +100, then press Enter.

Task 6: Publish the Private Data
You are satisfied with the Cost of Goods Sold private data value of 1100 and you would like to 
incorporate it into the Forecast data.

1. Publish the PrivateData as Forecast.
a) Right-click anywhere in the PrivateData column and choose Version → Publish

b) In the dialog select Forecast and choose Publish.

Result
Cost of Goods Sold for the Forecast version is now 1100. The PrivateData column is gone.

2. Save the story and return to the Home page.

Solution 8: Perform manual input planning
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Unit 6
Exercise 9

Use predictive forecast

Task Flow

In this exercise, you will perform the following tasks:

● Log on to SAP Analytics Cloud

● Copy a Model

● Create a New Story

● Run a Predictive Forecast

Task 1: Log on to SAP Analytics Cloud

1. Log on to SAP Analytics Cloud. Go to the next task if you are already logged on.

● User: A## or B##.

## is your 2-digit group number, and the letter is what your instructor assigned to you.

● Password: Welcome1

Task 2: Create a New Model

1. Access the P00M_Operating_Income_Plan planning model from the SACE11 content folder 
in the public area.

2. Copy the P00M_Operating_Income_Plan model and its data to My Files as follows:

Name Operating_Income_Plan_##
Description Operating Income Plan ##

 Include data

Task 3: Create a New Story

1. In a new story, add a canvas page with a time series chart to forecast data in the 
Operating_Income_Plan_## model.

2. Configure the time series chart as follows:

Field Value

Measure Gross Sales (use the field search)

Time Dimension Date
Filter:

Version Actual
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Field Value

Date (Member) 2017 Q1, Q2, Q3

3. Widen the chart.

4. Rename the page to Sales Forecast.

5. Save the story as follows:

Name U##S_Predictive_Forecast
Description U##S Predictive Forecast

Task 4: Run a Predictive Forecast
Using the predefined forecast function in SAP Analytics Cloud, predict how revenue will trend 
next year based on historical data.

1. In the time series chart, add an Automatic Forecast.
Result
The automatic forecast shows the data for the future and a part of the past. If you do not 
want to show the historical data, deselect Past Period Forecast via More Actions →  Show 
Hide).

2. OPTIONAL: Access styling for the chart and change the background to green so that you 
can see the icons on the next step more easily. Adjust the Data Points Fill Color to yellow 
and the Font color to white.

3. Select the full-screen option to see the details of your chart more easily.

4. In the time series chart, add a Linear Regression forecast.

5. In the time series chart, add a Triple Exponential Smoothing forecast.

6. Hover on a data point so that you can see the Confidence Interval.

Figure 7: Forecast Result

Result

7. Save the story from the ribbon or press Ctrl+S. Return to the Home page.

Exercise 9: Use predictive forecast
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Result
You have completed this exercise.

Unit 6: Explaining augmented analytics in SAP Analytics Cloud
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Unit 6
Solution 9

Use predictive forecast

Task Flow

In this exercise, you will perform the following tasks:

● Log on to SAP Analytics Cloud

● Copy a Model

● Create a New Story

● Run a Predictive Forecast

Task 1: Log on to SAP Analytics Cloud

1. Log on to SAP Analytics Cloud. Go to the next task if you are already logged on.

● User: A## or B##.

## is your 2-digit group number, and the letter is what your instructor assigned to you.

● Password: Welcome1

a) From your training remote desktop, launch Google Chrome.

b) Enter the URL (provided by your instructor) for the SAP Analytics Cloud tenant you will 
use in class.

c) Your instructor has assigned you to a group, either A or B, and also given you a 2-digit 
group number. Log on to SAP Analytics Cloud using the credentials above.

Task 2: Create a New Model

1. Access the P00M_Operating_Income_Plan planning model from the SACE11 content folder 
in the public area.
a) From the Navigation Bar choose Files →  Public →  SACE11_34 →  Content.

2. Copy the P00M_Operating_Income_Plan model and its data to My Files as follows:

Name Operating_Income_Plan_##
Description Operating Income Plan ##

 Include data

a) Select the P00M_Operating_Income_Plan model.

b) Near the top of the page, choose Copy To.

c) Choose My Files from the upper left corner of the dialog box and enter the information 
as shown in the preceding table.
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d) Choose OK.

Task 3: Create a New Story

1. In a new story, add a canvas page with a time series chart to forecast data in the 
Operating_Income_Plan_## model.
a) From the Navigation Bar choose Stories.

b) Choose Canvas.

c) In the Select Design Mode Type dialog, choose Classic Design Experience and click 
Create.

d) From the Add an object to the story canvas area, choose Chart.

e) In the Select Dataset or Model dialog box, choose your Operating_Income_Plan_## 
model.

f) Under Chart Structure on the right, use the Trend drop-down to select Time Series.

2. Configure the time series chart as follows:

Field Value

Measure Gross Sales (use the field search)

Time Dimension Date
Filter:

Version Actual
Date (Member) 2017 Q1, Q2, Q3

a) Configure the time series as shown above.

3. Widen the chart.

4. Rename the page to Sales Forecast.

a) Choose the dropdown arrow for Page 1 and choose Rename.

b) Type the new name for the page and choose Rename.

5. Save the story as follows:

Name U##S_Predictive_Forecast
Description U##S Predictive Forecast

a) In the toolbar, choose Save.

b) Enter the details as shown in the table and choose OK.

Task 4: Run a Predictive Forecast
Using the predefined forecast function in SAP Analytics Cloud, predict how revenue will trend 
next year based on historical data.

1. In the time series chart, add an Automatic Forecast.

Unit 6: Explaining augmented analytics in SAP Analytics Cloud
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a) In the time series chart, choose More Actions.

b) Choose Add →  Forecast →  Automatic Forecast.

Result
The automatic forecast shows the data for the future and a part of the past. If you do not 
want to show the historical data, deselect Past Period Forecast via More Actions →  Show 
Hide).

2. OPTIONAL: Access styling for the chart and change the background to green so that you 
can see the icons on the next step more easily. Adjust the Data Points Fill Color to yellow 
and the Font color to white.
a) In the Builder pane, choose Styling.

b) Change the Background Color to green.

c) In the Data Points section, change the Fill Color to yellow.

d) In the Font section, change the Color to white.

3. Select the full-screen option to see the details of your chart more easily.

a) Select the chart and choose  More.

b) Choose Fullscreen.

4. In the time series chart, add a Linear Regression forecast.

a) In the time series chart, choose More Actions.

b) Choose Add →  Forecast →  Advanced Options →  Linear Regression.

5. In the time series chart, add a Triple Exponential Smoothing forecast.

a) In the time series chart, choose More Actions.

b) Choose Add →  Forecast →  Advanced Options →  Triple Exponential Smoothing.

6. Hover on a data point so that you can see the Confidence Interval.

Solution 9: Use predictive forecast
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Figure 7: Forecast Result

Result

7. Save the story from the ribbon or press Ctrl+S. Return to the Home page.

Result
You have completed this exercise.

Unit 6: Explaining augmented analytics in SAP Analytics Cloud
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Unit 6
Exercise 10

Run Smart Discovery and use Smart Insights

Business Example

In this exercise, run a smart discovery within SAP Analytics Cloud. You will develop an 
understanding of the purpose of various pages that are created by smart discovery.

Based on the dataset in an existing story, you want to see what factors influence the salary 
you pay your employees. As you are not familiar with HR data, you want to use smart 
discovery in SAP Analytics Cloud which automatically creates a story for you.

Task Flow
● Copy an existing story.

● Run a smart discovery with acquired data.

● Explain the differences between the overview, key influencers, unexpected values, and 
simulation page.

● Use Smart Insights to gain intrinsic information about key contributors.

Task 1: Log on to SAP Analytics Cloud

1. Log on to SAP Analytics Cloud. Go to the next task if you are already logged on and you 
have created the course files (step 2).

● User: A## or B##.

## is your 2-digit group number, and the letter is what your instructor assigned to you.

● Password: Welcome1

Task 2: Copy an Existing Story

1. Copy the U00S_HR_Employee story as follows:

Name U##S_HR_SmartDiscovery
Description U## Employee Smart Discovery

Task 3: Run Smart Discovery

1. On the upper left, choose the My Files hyperlink.

2. Open the U##S_HR_SmartDiscovery story.

3. Switch to Edit mode. If prompted to use optimized view mode, choose No Thanks.

4. Run Smart Discovery from the More... menu (or use the  icon in the ribbon). If you 
see a Welcome! dialog, choose Got it.
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Result

Figure 8: Smart Discovery Start Screen

5. In the Smart Discovery panel, make the following selections:

Field Value

Target Annual Salary
Entity Employee ID
Advanced Settings:

Version Actual

Included Columns: All Measures

All Dimensions

6. Choose Preview.
Result
The preview displays an explanation of how Smart Discovery works and some sample 
values.

7. Choose Run.
Result
The story opens with several pages, such as Overview and Key Influencers. Your results 
may vary compared to the following image.

Unit 6: Explaining augmented analytics in SAP Analytics Cloud
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Figure 9: Employee Salaries by Location

8. Configure the Annual Salary by Employee ID bar chart to display office location.

a. On the lower right, click on the Annual Salary by Employee ID chart widget.

b. Use the Designer button to access the Builder pane.

c. The Comparison Chart type should be Bar/Column.

d. Set the measures and dimensions as follows:

● Annual Salary

● Dimensions = Office Location (remove Employee ID)

● Color = Annual Salary

9. Set the Drill for the chart to Level 4.

10. Run smart insights on New York City.

Exercise 10: Run Smart Discovery and use Smart Insights
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Result

Figure 10: New York City Smart Insights

Smart insights lets you gain more intrinsic information about a data point in your 
visualization. When you select a data point in your visualization and choose Smart 
Insights, a side panel appears with smart textual and visual insights on that particular data 
point.

11. Scroll down in the Smart Insights pane and expand the 24 is the top Age contributor.
Result
A chart with Annual Salary per Age for Actual is displayed.

12. Go to the Key Influencers page.
Result
Several dimensions are listed by level of influence. Position has a moderate influence on 
annual salary. The left panel contains a text area called About this Smart Discovery. Lower 
in the page, there are two lists of key influencers to pick from: Select a key influencer from 
List A to see how it has an impact on Annual Salary for Employee ID and Select a different 
key influencer from List B to see how the relationship between it and Position has an impact 
on Annual Salary for Employee ID.

13. In list A, which employment type is the highest?
Result
Full time has the highest impact.

14. On the Key Influencers page, check the distribution of annual salary by position. It is 
evident that the company is spending significantly more on the (VP) position. Explore 
what factors contribute to this.

15. Continuing in the Key Influencers page, investigate how the department impacts annual 
salary.
Result
It is evident that on average the Sales employees are paid more than any other 
department.

Unit 6: Explaining augmented analytics in SAP Analytics Cloud
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16. Go to the Unexpected Values page. Which combination had the highest percentage 
difference?

Note:
Your values may vary.

Figure 11: Smart Discovery

17. Choose the Simulation tab. Choose Got it if prompted. What is the annual salary for a 
Manager vs. a Specialist?
Result

Figure 12: Smart Discovery

If the position is set to Specialist, the impact is negative since the annual salary is lower.

18. Save the story and return to the Home page.
Result
You have completed this exercise.

Exercise 10: Run Smart Discovery and use Smart Insights
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Unit 6
Solution 10

Run Smart Discovery and use Smart Insights

Business Example

In this exercise, run a smart discovery within SAP Analytics Cloud. You will develop an 
understanding of the purpose of various pages that are created by smart discovery.

Based on the dataset in an existing story, you want to see what factors influence the salary 
you pay your employees. As you are not familiar with HR data, you want to use smart 
discovery in SAP Analytics Cloud which automatically creates a story for you.

Task Flow
● Copy an existing story.

● Run a smart discovery with acquired data.

● Explain the differences between the overview, key influencers, unexpected values, and 
simulation page.

● Use Smart Insights to gain intrinsic information about key contributors.

Task 1: Log on to SAP Analytics Cloud

1. Log on to SAP Analytics Cloud. Go to the next task if you are already logged on and you 
have created the course files (step 2).

● User: A## or B##.

## is your 2-digit group number, and the letter is what your instructor assigned to you.

● Password: Welcome1

a) From your training remote desktop, launch Google Chrome.

b) Enter the URL (provided by your instructor) for the SAP Analytics Cloud tenant you will 
use in class.

c) Your instructor has assigned you to a group, either A or B, and also given you a 2-digit 
group number. Log on to SAP Analytics Cloud using the credentials above.

Task 2: Copy an Existing Story

1. Copy the U00S_HR_Employee story as follows:

Name U##S_HR_SmartDiscovery
Description U## Employee Smart Discovery

a) Navigate to Files →  Public →  SACE11_34 →  Content.

b) Select the  U00S_HR_Employee story.
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c) Choose  Copy.

d) Choose My Files from the upper left corner of the dialog box and enter the information 
as shown in the preceding table.

Task 3: Run Smart Discovery

1. On the upper left, choose the My Files hyperlink.

2. Open the U##S_HR_SmartDiscovery story.

3. Switch to Edit mode. If prompted to use optimized view mode, choose No Thanks.

4. Run Smart Discovery from the More... menu (or use the  icon in the ribbon). If you 
see a Welcome! dialog, choose Got it.
Result

Figure 8: Smart Discovery Start Screen

5. In the Smart Discovery panel, make the following selections:

Field Value

Target Annual Salary
Entity Employee ID
Advanced Settings:

Version Actual

Included Columns: All Measures

All Dimensions

6. Choose Preview.
Result
The preview displays an explanation of how Smart Discovery works and some sample 
values.

7. Choose Run.

Solution 10: Run Smart Discovery and use Smart Insights
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Result
The story opens with several pages, such as Overview and Key Influencers. Your results 
may vary compared to the following image.

Figure 9: Employee Salaries by Location

8. Configure the Annual Salary by Employee ID bar chart to display office location.

a. On the lower right, click on the Annual Salary by Employee ID chart widget.

b. Use the Designer button to access the Builder pane.

c. The Comparison Chart type should be Bar/Column.

d. Set the measures and dimensions as follows:

● Annual Salary

● Dimensions = Office Location (remove Employee ID)

● Color = Annual Salary

9. Set the Drill for the chart to Level 4.

a) Click the  Set Drill icon in the chart widget, and choose Level 4.

10. Run smart insights on New York City.
a) Right-click the New York City bar and select Smart Insights.

b) Expand the first entry to see Annual Salary per Employee ID for Actual.

Unit 6: Explaining augmented analytics in SAP Analytics Cloud
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Result

Figure 10: New York City Smart Insights

Smart insights lets you gain more intrinsic information about a data point in your 
visualization. When you select a data point in your visualization and choose Smart 
Insights, a side panel appears with smart textual and visual insights on that particular data 
point.

11. Scroll down in the Smart Insights pane and expand the 24 is the top Age contributor.
Result
A chart with Annual Salary per Age for Actual is displayed.

12. Go to the Key Influencers page.
Result
Several dimensions are listed by level of influence. Position has a moderate influence on 
annual salary. The left panel contains a text area called About this Smart Discovery. Lower 
in the page, there are two lists of key influencers to pick from: Select a key influencer from 
List A to see how it has an impact on Annual Salary for Employee ID and Select a different 
key influencer from List B to see how the relationship between it and Position has an impact 
on Annual Salary for Employee ID.

13. In list A, which employment type is the highest?
a) Under List A, select Employment Type.

Result
Full time has the highest impact.

14. On the Key Influencers page, check the distribution of annual salary by position. It is 
evident that the company is spending significantly more on the (VP) position. Explore 
what factors contribute to this.
a) Choose the Position radio button under List A. The chart on the right hand changes 

accordingly.

b) Right-click VP and choose Smart Insights. Expand the entry under How is this 
calculated?

Solution 10: Run Smart Discovery and use Smart Insights
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15. Continuing in the Key Influencers page, investigate how the department impacts annual 
salary.
a) Choose the Department radio button under List A.

b) The chart on the right hand changes accordingly.

Result
It is evident that on average the Sales employees are paid more than any other 
department.

16. Go to the Unexpected Values page. Which combination had the highest percentage 
difference?

Note:
Your values may vary.

Figure 11: Smart Discovery

17. Choose the Simulation tab. Choose Got it if prompted. What is the annual salary for a 
Manager vs. a Specialist?
a) In the Impact column, make your selections as you see in the Smart Discovery image.

b) Choose Simulate.

Result

Figure 12: Smart Discovery

If the position is set to Specialist, the impact is negative since the annual salary is lower.

18. Save the story and return to the Home page.

Unit 6: Explaining augmented analytics in SAP Analytics Cloud
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Result
You have completed this exercise.

Solution 10: Run Smart Discovery and use Smart Insights
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Unit 7
Exercise 11

Provide feedback using discussion and 
comments

You are part of an international team responsible for analyzing the information in the 
U##S_First_Story story. You need to communicate with your team members regarding the 
story and information in it, and you decide to use SAC's discussion and comments 
functionality.

Task Flow

In this exercise, you will perform the following tasks:

● Open an existing story

● Start a discussion with your team

● Add a comment on a widget in the story

1. Open your U##S_First_Story.

Note:
You should not be prompted to log on but if you are, try to  reload (directly 
above the SAP logo) the SAP Analytics Cloud browser. This story accesses 
data from live SAP HANA views and since single sign-on is enabled, you should 
not be prompted to log on.

2. Start a new discussion with your team. Include a link to the U##S_First_Story story and 
comment to check out the Finance page.

3. Go back to the Home screen.

4. Use the Collaboration icon to see if anyone has started a discussion with you.

5. Insert a comment in the # of Orders KPI. Use a bold font.

6. Return to the Home screen.
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Unit 7
Solution 11

Provide feedback using discussion and 
comments

You are part of an international team responsible for analyzing the information in the 
U##S_First_Story story. You need to communicate with your team members regarding the 
story and information in it, and you decide to use SAC's discussion and comments 
functionality.

Task Flow

In this exercise, you will perform the following tasks:

● Open an existing story

● Start a discussion with your team

● Add a comment on a widget in the story

1. Open your U##S_First_Story.

Note:
You should not be prompted to log on but if you are, try to  reload (directly 
above the SAP logo) the SAP Analytics Cloud browser. This story accesses 
data from live SAP HANA views and since single sign-on is enabled, you should 
not be prompted to log on.

2. Start a new discussion with your team. Include a link to the U##S_First_Story story and 
comment to check out the Finance page.

a) On the upper right, choose  Collaboration to initiate a new discussion.

b) Choose the + icon to invite other users or teams to this specific discussion. In your 
case, use either Team A or Team B, based on which Team you are using for this 
course.

c) In the Discussion pane, scroll down to the bottom and link your story U##S_First_Story 
to this specific discussion using the + icon.

d) Enter a comments, such as Check out the Finance page and send it.

3. Go back to the Home screen.

4. Use the Collaboration icon to see if anyone has started a discussion with you.

5. Insert a comment in the # of Orders KPI. Use a bold font.
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a) On the upper left, choose the point chart called # of Orders. Choose the More 

Actions icon and choose Add →  Comment. Enter a comment of your choice. Change 
to a bold font. Choose Add Comment.

b) Close the Comment box.

6. Return to the Home screen.

Unit 7: Using collaboration features
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Unit 7
Exercise 12

Build a calendar task

Business Example

You want to use the SAP Analytics Cloud Calendar to collaborate with a colleague.

Task Flow

In this exercise you will:

● Copy, share, and modify an existing story.

● Create a Composite Task in the Calendar that defines PUSERA/B as the Reviewer.

● Send a message to your reviewer indicating you removed dimensions from the table.

● As PUSERA/B, review and approve the story.

● As A/B##, view your calendar task to see that it is completed.

Note:
In this exercise, when a value or object name includes ##, replace ## with the 
number that your instructor assigned to you.

Task 1: Logon to SAP Analytics Cloud

1. Log on to SAP Analytics Cloud.

Username: A## or B##, where ## is your 2-digit group number, and the letter is what 
your instructor assigned to you.

Password: Welcome1

Task 2: Copy, Share, and Modify the Story

1. Copy the P00S_HR_Employee story in the SACE11_34 content folder.

2. Copy the P00S_HR_Employee story as follows:

Field Value

Name U##S_Cal_Scen
Description U## Calendar Scenario

3. Share your U##S_Cal_Scen story with PUSERA/B with Full Control.

4. Open your U##S_Cal_Scen story in Edit mode, remove all dimensions from the existing 
table except Office Location and Position.

5. Save the story.
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Task 3: Create a Composite Task in the Calendar with a Reviewer.

1. Access the Calendar.

2. Switch to the list view and turn off the Gantt chart.

3. Add a Composite Task named U##T_NewStory that starts 5 minutes from the current 
date and time.

4. Configure the Task to add to the Task the U##S_Cal_Scen story as a Work File and name 
your User as the Assignee and PUSERA/B as the Reviewer.

5. To give the Reviewer more time to review the story, continue configuring the Task to 
change the Distribution of the task to 25% for the Assignee and 75% for the Reviewer.
Result
Here is an example for an A## user:

Figure 13: Composite Task Example

6. At the start time of the Task, reload the SAP Analytics Cloud page.
Result
The Overall Status changes to In Progress.

7. As the Assignee of the Task, add a comment to the Reviewer to explain that you removed 
dimensions from the rows of the table and submit this change to the task.
Result

Note:
If the Submit button is not active, check the start date/time for the task. Make 
sure it is set for the current day and time.

Task 4: As PUSERA/B, Review and Approve the Story
You are now acting as the Reviewer of the information submitted by the Assignee. You will log 
on as the PUSERA or PUSERB user in a Chrome Incognito session.

1. In a Chrome incognito session, log on as the reviewing user:
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User Password

If you are using the A Team: PUSERA | If you 
are using the B Team: PUSERB

Welcome1

Result
You now have two Chrome sessions, but you see only the Incognito session.

2. View your PUSERA/B Notifications and open the story you are to review.
Result
The story opens. Under the main task bar are options to Approve, Reject, and Decline as 
well as a button to view the Details of the task.

3. View the story and then respond that the story is fine.

4. Approve the story.
Result
The Discussions and Composite Task panes indicate that the Task has been 
accomplished.

5. Close the Incognito browser tab.

Task 5: As the A/B## User View Your Calendar Task to See That It Is Completed.

1. In the Calendar for your A/B## user, view the status of the task in the List view.
Result
The Status column indicates Accomplished and the Progress column shows that your 
U##T_NewStory task is 100% complete.

2. Go to the Home page.
Result
You have completed this exercise.
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Unit 7
Solution 12

Build a calendar task

Business Example

You want to use the SAP Analytics Cloud Calendar to collaborate with a colleague.

Task Flow

In this exercise you will:

● Copy, share, and modify an existing story.

● Create a Composite Task in the Calendar that defines PUSERA/B as the Reviewer.

● Send a message to your reviewer indicating you removed dimensions from the table.

● As PUSERA/B, review and approve the story.

● As A/B##, view your calendar task to see that it is completed.

Note:
In this exercise, when a value or object name includes ##, replace ## with the 
number that your instructor assigned to you.

Task 1: Logon to SAP Analytics Cloud

1. Log on to SAP Analytics Cloud.

Username: A## or B##, where ## is your 2-digit group number, and the letter is what 
your instructor assigned to you.

Password: Welcome1

a) From your training remote desktop, launch Google Chrome.

b) Type the URL (provided by your instructor) for the SAP Analytics Cloud Tenant you will 
use in class.

c) Your instructor has assigned you to a group, either A or B, and also given you a 2-digit 
group number. Log on to SAP Analytics Cloud using the provided credentials.

Task 2: Copy, Share, and Modify the Story

1. Copy the P00S_HR_Employee story in the SACE11_34 content folder.
a) On the upper left, go to Files.

b) Go to Public → SACE11_34 →  Content.

2. Copy the P00S_HR_Employee story as follows:
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Field Value

Name U##S_Cal_Scen
Description U## Calendar Scenario

a) Select the  P00S_HR_Employee story.

b) Near the top of the page, choose Copy To .

c) Choose My Files from the upper left corner of the dialog box and enter the information 
as shown in the preceding table.

d) Choose OK.

3. Share your U##S_Cal_Scen story with PUSERA/B with Full Control.

a) Open the  Navigation Bar if needed. On the top left, choose Files.

b) Select your  U##S_Cal_Scen story.

c) To use the share function, choose the  icon .

d) Select Share.

e) In the pop-up window, enter either PUSERA or PUSERB (depending on what group 
your class is using).

f) Choose OK.

g) Change the Access to Full Control.

h) Choose Share and then choose Close.

4. Open your U##S_Cal_Scen story in Edit mode, remove all dimensions from the existing 
table except Office Location and Position.
a) From My Files, click the U##S_Cal_Scen story to open it.

b) Select the table.

c) Choose Designer.

d) In the Builder pane on the right, remove all dimensions from the Rows except Office 
Location and Position.

5. Save the story.

Task 3: Create a Composite Task in the Calendar with a Reviewer.

1. Access the Calendar.

a) Open the  Navigation Bar and choose Calendar. It may be located under the 

 ...More option.

b) If prompted, close the Calendar Release Highlights dialog.
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2. Switch to the list view and turn off the Gantt chart.
a) On the upper left, go to the List view.

b) In the ribbon, choose  Hide Gantt Char.

3. Add a Composite Task named U##T_NewStory that starts 5 minutes from the current 
date and time.
a) In the Calendar toolbar at the top of the screen choose + Add →  Composite Task.

b) In the Name field, type U##T_NewStory.

c) Choose the calendar icon in the Start Date field, and change the Minutes to 5 minutes 
from the current time.

d) Choose Create.

4. Configure the Task to add to the Task the U##S_Cal_Scen story as a Work File and name 
your User as the Assignee and PUSERA/B as the Reviewer.
a) Near the top of the Composite Task pane, choose + Add File.

b) Choose the U##S_Cal_Scen story and click OK.

c) Scroll to the Assignees section.

d) Click +Add Assignees and choose your User (either A## or B##).

e) Scroll to the Reviewers section.

f) Click + Add Reviewers and choose either PUSERA or PUSERB, depending on your 
course Team, and click OK. CAUTION: Do not click the drop-down. Click directly on the 
words Add Reviewers.

5. To give the Reviewer more time to review the story, continue configuring the Task to 
change the Distribution of the task to 25% for the Assignee and 75% for the Reviewer.
a) Continuing in the Composite Task pane, scroll up to the Distribution section and move 

the slider so that the Assignee has 25% of the task and the Reviewer 75%.

b) At the bottom of the Composite Task pane, choose Update.

c) If possible, choose Activate → OK.

Result
Here is an example for an A## user:

Unit 7: Using collaboration features

© Copyright. All rights reserved. 80



Figure 13: Composite Task Example

6. At the start time of the Task, reload the SAP Analytics Cloud page.

a) Below the SAP Learning Class logo, click the  Reload this page button for the SAP 
Analytics Cloud browser tab.

Result
The Overall Status changes to In Progress.

7. As the Assignee of the Task, add a comment to the Reviewer to explain that you removed 
dimensions from the rows of the table and submit this change to the task.

a) In the Composite Task pane, choose the  Open Discussions icon at the top of the 

pane, to the right of the Task title.

b) At the bottom of the Discussions pane, type I removed dimensions from the 
table. Is this okay? in the Type a message ... area and press Enter.

c) In the Composite Task pane on the lower right, choose Submit and choose Submit in 
the ? Submit dialog.

Result

Note:
If the Submit button is not active, check the start date/time for the task. Make 
sure it is set for the current day and time.

Task 4: As PUSERA/B, Review and Approve the Story
You are now acting as the Reviewer of the information submitted by the Assignee. You will log 
on as the PUSERA or PUSERB user in a Chrome Incognito session.

1. In a Chrome incognito session, log on as the reviewing user:
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User Password

If you are using the A Team: PUSERA | If you 
are using the B Team: PUSERB

Welcome1

a) Copy (Ctrl+C) the SAP Analytics Cloud tenant URL.

b) On the upper right in the SAP Analytics Cloud Chrome browser, go to Customize 

and choose New Incognito Window.

c) Paste (Ctrl+V) the SAP Analytics Cloud tenant URL.

d) Log on as instructed above.

Result
You now have two Chrome sessions, but you see only the Incognito session.

2. View your PUSERA/B Notifications and open the story you are to review.

a) In the upper right, choose the  Notification icon.

b) Select the Your task U##T_NewStory is now open notification.

Result
The story opens. Under the main task bar are options to Approve, Reject, and Decline as 
well as a button to view the Details of the task.

3. View the story and then respond that the story is fine.
a) Click the Details button.

b) Choose the  Open Discussions icon. 

c) At the bottom of the Discussions pane, type This story looks fine. Thanks! in 
the Type a message ... area on the lower right and press Enter.

4. Approve the story.
a) Choose the Approve button below the main task bar.

b) Choose Approve in the ? Approve dialog.

Result
The Discussions and Composite Task panes indicate that the Task has been 
accomplished.

5. Close the Incognito browser tab.

Task 5: As the A/B## User View Your Calendar Task to See That It Is Completed.

1. In the Calendar for your A/B## user, view the status of the task in the List view.

a) Open the  Navigation Bar and choose Calendar. (It may be located under the 

 More option.)

b) In the upper left corner of the Calendar, click List.
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Result
The Status column indicates Accomplished and the Progress column shows that your 
U##T_NewStory task is 100% complete.

2. Go to the Home page.
Result
You have completed this exercise.
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